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Migrating Advanced and Classic Historian Data

Why You Should Read This Manual
Migrating Advanced and Classic Historian Data is intended for users who are responsible
for migrating their Classic or Advanced Historian systems to iHistorian. This manual
assumes that you are familiar with the iFIX Advanced Historian or Classic Historian
environments.
Reference Documents
For related information about iHistorian, refer to the following documents:
•

Getting Started with iHistorian

•

Using the iHistorian Administrator

•

iHistorian Data Collectors

For more information on running iFIX, refer to the iFIX Electronic Books.
If you plan on implementing Electronic Signatures and Electronic Records or
iHistorian Security, Intellution recommends that you perform migration prior to
setting up or initializing these features. If the migration will be a gradual process over
time, please review the sections provided on Electronic Signatures and Electronic
Records and Implementing iHistorian Security.

Why You Should Read This Manual
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1. Introduction to the iHistorian Migration
Utilities
iHistorian provides two utilities that allow you to migrate your existing Classic and
Advanced Historian configuration and data into the iHistorian environment. The
iHistorian migration tools are designed to help you migrate your data quickly and
easily. The tools allow you to:
•

Select which Advanced Historian tags or Classic Historian archive files to
migrate.

•

Set up configuration options.

•

Migrate data into your iHistorian system.

This manual describes the steps for planning your Historian migration and performing
the migration of your data from both the Advanced Historian and Classic Historian
environment, including:
•

Planning Your Migration

•

Planning Migrations with Online Systems

•

Migrating Classic Historian Data

•

Configuring Classic Migration Options

•

Exploring the Advanced Historian to iHistorian Migration Utility

•

Migrating Existing Advanced Historian Data

•

Migrating Remote Advanced Historian Data

1. Introduction to the iHistorian Migration Utilities
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Before You Begin
Before you start migrating your Classic or Advanced Historian data, be aware of the
following:
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•

Confirm that your iHistorian environment is set up. For more information,
refer to the Getting Started with iHistorian manual.

•

Confirm that you have ample disk space on the archive machine. Assume that
you need to have at least as much free space as the amount of data that you
intend to migrate. For example, if you have 300MB of Advanced Historian
data, you need at least 300MB free disk space on the iHistorian Server to
accept that data.

•

Do not uninstall Advanced Historian until you have migrated all the data to
your iHistorian. Advanced Historian must be running and have its
components in place in order to migrate. The iHistorian Server that you are
migrating to does not need to be on the same computer as the Advanced
Historian or Classic data that you are migrating.

•

Migrating a large amount of data from Advanced or Classic Historian into
iHistorian may take a substantial amount of time, depending on the size of the
database and the processing power of your machines. For more information
refer to the Estimating Migration Time section.

•

When migrating Historical data from a SCADA node to an iHistorian Server,
Intellution recommends that you have an iFIX database loaded for the
corresponding iFIX historical tags (on the source machine) prior to migration
so that descriptions and EGUs can be retrieved.

•

When migrating Historical data to iHistorian, Intellution recommends that you
migrate the data in chronological order from the oldest to the newest. This
prevents adding data out of order, which may impact migration performance
and disk space usage.

•

Migrate collection groups before historical data to maintain collection rates
and deadbands.

•

For iHistorian systems that are not yet online, Intellution recommends that you
migrate existing historical data before putting the collectors online to improve
performance.

Migrating Advanced and Classic Historian Data

NOTE: For iHistorian systems that are already online, you may still migrate
data while the collectors are running. Be aware, however, that this will have
a negative effect on performance.

Planning Your Migration
In order to successfully migrate your data from its existing iFIX or Advanced
Historian platform into the iHistorian system, you should first plan out a sound
migration strategy. Consider the following questions when planning your migration:

Question

Refer to section

How should I be adding tags to
the archive?

Adding Tags to the Archive

Should I compress my data?

Planning Compression

In what order should I migrate
my data?

Recommended Migration Order

Do I need any security rights to
migrate my data?

Implementing Security During Migration

What if my data is being
migrated into an already active
iHistorian system?

Planning Migrations with Online Systems

Should I account for Daylight
Savings Time or Time Zone
differences?

Planning Daylight Savings Time

How long will my migration
take?

Estimating Migration Time

What if my ADH archives have
been moved around or I’m
attempting to migrate backups
of older ADH archives?

Registering Your Advanced Historian
Archives

Is there anything I should do
after migrating?

After Migrating Your Data

1. Introduction to the iHistorian Migration Utilities
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Adding Tags to the Archive
You must have tags in iHistorian to hold the migrated data. You can add tags
automatically during group migration, data migration, or manually prior to migration
using the iHistorian Administrator. When you add tags by migration, you can set the
maximum number of tag properties when the migration program has access to the real
time database. Having access to the iFIX real time database allows the program to
retrieve the Description, HI and LO Engineering Units, and Engineering Unit
descriptions. These are not stored in the Classic Historian data or group files.
Migrating group files will add tags for immediate collection. Immediate collection
occurs as a result of migrating the collection interval during the process of migrating
the group files. Qualifier and phase values are not preserved; deadband values are
preserved.

Planning Compression
To enable archive compression during migration:
[1]

Add the tags through the iHistorian Administrator or,
Migrate the historical groups.

[2]

After the tags are added to iHistorian, enable archive compression for each tag
through the iHistorian Administrator before migrating the Classic Historian
data.

[3]

The migrated data can then pass through archive compression during
migration.

Collector compression is automatically configured for collection groups that have a
configured deadband in HTA when those collection groups are migrated to
iHistorian.
By default, tags are migrated with archive compression turned off. Only archive
compression has any effect on migration.
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Recommended Migration Order
When migrating historical data to iHistorian, Intellution recommends that you
migrate the data in chronological order from oldest to newest. This prevents adding
data out of order, which may impact migration performance. Intellution also
recommends that you migrate collection groups before data.

Planning Migrations with Online Systems
If you are migrating your historian data into an already existing iHistorian tag
database, you may discover that tags with the same name exist in both the iHistorian
database and the iFIX or Advanced Historian database.
If you are migrating Classic Historian data and decide to select the Overwrite Existing
Tags option in the Migration Options dialog box, the existing iHistorian tag
properties will be replaced by the migrated Classic Historian tag properties and some
configuration properties will be overwritten. If you decide to clear the Overwrite
Existing Tags option, tag information will not migrate into the iHistorian tag
database.
NOTE: Do not attempt to migrate the currently collecting Classic Historian file. If
you do, you may receive an Error -9.
If you are migrating Advanced Historian data and decide to select the Allow Updates
to Existing Data option in the Advanced Historian to iHistorian Migration Utility, the
existing iHistorian tag data will be replaced by migrated Advanced Historian tag data
if the data points have the same timestamps. If you decide to clear the Allow
Updates to Existing Data option, the data will not be migrated (replaced) where there
is existing data with duplicate timestamps in iHistorian.
Limiting Processing Load on Server During Migration
Both Migration Utilities provide you with the ability to limit the amount of
processing load on the server during migration. This allows your online iHistorian
Server to continue processing data efficiently while migration occurs. By modifying
the Events rate/second field in the Classic Historian Migration Options dialog box or
the Max values/sec field in the Advanced Historian to iHistorian Migration Utility,
you can specify how much data is sent and therefore how much processing power the
Migration Utility receives on your system. The minimum you can set this rate to is
10,000 (or 0, meaning no throttle); the maximum you can set this field to is 100,000.

1. Introduction to the iHistorian Migration Utilities
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If you are performing a migration on a computer that is also processing other data or
applications, you may want to set the event processing speed lower to allow your
other applications to process well. The iHistorian Classic Migration and Advanced
Historian Migration defaults to 10,000 events per second. This default allows you to
throttle back the Migration Utility to allow for other applications processing, as well
as continue running your Migration Utility at a reduced speed.
If you are not running other data or applications on your machine and you want to run
the Migration Utility at maximum speed, set the Events rate/second or Max Values/
sec fields to 0.
Intellution recommends that you do not set the events per second past 25,000 or
below 10,000 (unless to 0). The higher the events per second, the faster your
Migration Utility processes the migration. For example, the migration may take twice
as long at 10,000 as it will at 20,000.
NOTE: You cannot change this entry while migrating. It must be set prior to or
changed after migration.

Implementing Security During Migration
In order to migrate data into the iHistorian System, you must be a member of the
appropriate predefined iHistorian Security Groups if you have implemented
iHistorian security. Refer to the iHistorian Group Rights section for information on
the individual groups required for each task. If any existing iHistorian Security
groups are defined, you must supply a username and password before migrating your
data in either the Migration Options dialog box (for Classic Historian) or the
Advanced Historian to iHistorian Migration Utility dialog box (for Advanced
Historian).

Planning Daylight Savings Time
When migrating Classic Historian data using the Migration Utility, you can select
whether or not you want to apply Daylight Savings Time (DST) bias to timestamps.
The Migration Utility converts the timestamps of migrated samples to UTC time
(universal time format for storing timestamps) before writing the data to iHistorian. If
you select this option, the Migration Utility will apply the DST offset before
converting to UTC time. The timestamps are converted to UTC time by adjusting the
time based on the local computer time zone offset and DST setting. If you enabled
DST in your operating system during Classic Collection, you must select the Treat as
DST Timestamp option.
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NOTE: Classic Historian and Advanced Historian assume that the computer you
are migrating your data from and the computer that you are migrating your data to
are in the same Time Zone.

Estimating Migration Time
Migrating a large historical database from either Advanced or Classic Historian into
iHistorian may take a substantial amount of time, depending on the size of the
database and the processing power of your machines.
To estimate migration time, refer to the total file size of the migration files. For
Classic Historian migration, Intellution roughly estimates that it takes one minute to
migrate 3 to 8.3 MBs of data. For the quickest migration, Intellution recommends
that you clear the Migrate Current Alarm and the Readback Values option, if they are
not required, in the Classic Historian Migration Options dialog box.
For Advanced Historian data, Intellution roughly estimates that it takes about 30
minutes to migrate 100 MB of data. This estimation assumes a default throttling of
10,000 events per second. If you have modified your Max Values/sec field in
Advanced Historian, your migration time may differ. For more information, refer to
Limiting Processing Load on Server During Migration.
NOTE: In addition to migration file size, migration time depends upon the
processing power of the computer running the Migration Utility. Intellution highly
recommends that you select a computer with high processing power to run the
migration program.

Registering Your Advanced Historian Archives
If you have changed the original location of your archives or you have backups of
older archives that you wish to migrate, you must enable those archives by registering
them. Use the following guidelines when registering your archives:
•

No other archive can hold data in the same time frame.

•

Archives must be registered using PIARTOOL -AR {Full Path of file}.

•

PIARTOOL - AL must show that the archive is registered prior to migration.
Refer to your Advanced Historian documentation for more information about
the PIARTOOL.
1. Introduction to the iHistorian Migration Utilities
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Any unregistered archives will not be migrated. For more information on registering
your archives, refer to step 2 of Migrating Remote Advanced Historian Data.

After Migrating Your Data
After migrating your data, ensure that you are no longer running HTC (Historical
Collect). If you have HTC configured to start automatically from the iFIX
WorkSpace, remove HTC from the SCU task startup list and replace it with the iFIX
Collector.

Adding the iHistorian Toolbar
To configure the toolbar to appear in the WorkSpace:
[1]

Start iFIX v2.5 or greater. The Intellution Dynamics WorkSpace opens, if so
configured.

[2]

Select Toolbars from the WorkSpace menu. The Toolbars dialog box appears.

[3]

Click the Customize button. The Customize Toolbars dialog box appears.

[4]

Click the Import button. The Import Toolbars dialog box appears.

[5]

Select the iHistorian.

[6]

Click the Import button. The iHistorian Toolbar, shown in Figure 1-1,
appears.

[7]

Click the Close button to close the Import Toolbars dialog box.

[8]

Click the Close button to return to the WorkSpace.

Figure 1-1: iHistorian Toolbar
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Configure iHistorian Servers Button
The Configure iHistorian Servers button in the iHistorian Toolbar specifies the
location of historical data retrieval for the WorkSpace, not the location of the
historical data storage. You can view/retrieve data stored on these listed servers
while you select a pen for a chart display. The Configure iHistorian Servers dialog
box also determines where HDA programs and historical ODBC retrieve data from,
which is always the default server.

Overview Checklist
The following is a list of general tasks for migrating your data to an online or new
iHistorian system.
[1]

Verify that you are familiar with the setup recommendations. How?

[2]

Estimate the number of archives that iHistorian will create during migration
and verify that you have enough disk space to accommodate the new archives
and backups of those archives. How?

[3]

Migrate all collection groups. How?
If you are migrating to an online iHistorian system and tags exist in the iFIX
database, the collector begins collecting on those tags.

[4]

Export tag configuration information.

[5]

Migrate Classic Historical data or, How?
Migrate Advanced Historical data. How?

[6]

Backup the newly created archives.

[7]

Start your collectors.

1. Introduction to the iHistorian Migration Utilities
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[8]
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Verify data through one of the following options:
•

iFIX chart

•

Raw data dump into OLE DB

•

Classic Historian log file

•

Data Readback Verification option in the Classic (optional) and
Advanced (automatic) Migration utilities

Migrating Advanced and Classic Historian Data

2. Migrating Classic Historical Data
iHistorian supplies a utility that allows you to migrate your existing Classic Historian
data (used in FIX32 and iFIX) into your iHistorian tag database. Before migrating
your Classic Historian data, plan your migration thoroughly. Refer to Planning Your
Migration for more information.
Once you have planned your Classic Historian migration, perform the following
steps:
[1]

Add the iHistorian Toolbar to the iFIX WorkSpace. How?

[2]

Configure Classic Historian Migration Options. How?

[3]

Migrate existing groups. How?

[4]

Migrate your Classic Historian Data. How?

Migrating Classic Historian Data
The following procedure describes how to migrate Classic Historian data into your
iHistorian database. For more information and tips on migrating data into a currently
active iHistorian Archive (one that is currently collecting new data as well), please
refer to the Planning Migrations with Online Systems section of this manual.
NOTE: When migrating data, Classic Historian nodes must be online with a loaded
database so that descriptions and EGU values can be retrieved.
To migrate Classic Historian data into the iHistorian:
[1]

Click the iHistorian Migration Button, shown in Figure 2-1, to open the
iHistorian Migration Utility.

Figure 2-1: iHistorian Migration Button

2. Migrating Classic Historical Data
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[2]

Select Configure Options from the Options menu.

[3]

Enter or modify any specific configuration information. For more
information, refer to the Configuring Classic Migration Options section.

[4]

Select Migrate Collection Groups from the File menu. The Utility prompts
you to specify if you would like to migrate all groups.
The iHistorian Classic Migration Utility connects to the specified server and
migrates the groups.
NOTE: When migrating groups, Qualifier and Phase parameters are not
migrated. If a group is not active, it is still migrated to the iHistorian.
Groups are not preserved in iHistorian. All tags are added to iHistorian with
the collection rate for the group.

[5]

Select Migrate Historical Data from the File menu. The Select Historical Data
File(s) dialog box appears.

[6]

Select one or more historical files and click Open.
The Migration Utility attempts to migrate all Historical Data. The title bar
displays the current file status (1 of 5, for example). Refer to the Migration
Utility main screen for information on the progress of the migration and any
encountered errors.
NOTE: The Migration Utility screen only displays the most recent lines of the
log file. For the full set of logged messages, refer to the log file, typically
located in C:\Dynamics\Local\iFIX2IhMigration.Log.

Configuring Classic Migration Options
Open the Migration Options dialog box, shown in Figure 2-2, by selecting Configure
Options from the Options menu in the iHistorian Classic Migration Utility.
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The Classic Historian Migration Tool automatically detects the default server and
displays the default migration options. Some of the options that you can configure
include:
•

iHistorian Server Options

•

THISNODE Options

•

Tag Add Options

•

Logfile Options

•

Tag Add Options

•

Readback Options

2. Migrating Classic Historical Data
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Figure 2-2: Classic Historian Migration Options Dialog Box

iHistorian Server Options
Allows you to set up your server information, limit or expand the application
processing time, and input any needed security information.
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The iHistorian Server Options include:

Field

Description

iHistorian Server

The default server (set during installation).
If you do not want to store data on the
default server, enter the desired connected
server in this field.

iHistorian Username and
Password

If you have created and established
Security Groups in your iHistorian
Security Environment, you may need to
enter the username and password here. By
default, if you do not supply any
information, the current logged in user
will be checked. For more information
about iHistorian Security, please refer to
the Implementing iHistorian Security
chapter of the Getting Started with
iHistorian manual.

Event rate/sec

Allows you to limit the amount of server
load caused by the Migration Utility. By
reducing the Events/rate per second field
in the Migration Options dialog box, you
can allocate more time to real time
collection. The default rate is 10,000. For
more information, refer to Limiting
Processing Load on Server During
Migration.

THISNODE Options
Specifies the Node name to use if you are migrating data with THISNODE. The
utility automatically defaults to the name of the local iFIX node. If you want to
change the Node name, enter a different Node name in this field.

2. Migrating Classic Historical Data
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Tag Add Options
Allows you to set the following options:

The Field...

Specifies...

Overwrite Existing Tags

Selecting this option allows iHistorian to
replace certain tag properties if the tags
already exist in the iHistorian tag
database.

Migrate Current Alarm

Whether or not the Migration Utility
separates the Current Alarm tags
(B_CUALM) out and adds them to the
iHistorian database. Classic Historian
paired the B_CUALM tag inside another
tag and counted it as one. If this is
enabled, the iHistorian Classic Migration
Utility will separate these tags and add
them both to the tag database.
For example:

The Classic Historian Tag:
FIX.TAG1.F_CV
will convert to the iHistorian Tags:
FIX.TAG1.F_CV
FIX.TAG1.B_CUALM
NOTE: If you clear the Migrate Current
Alarm box, the Current Alarm tags are not
created and the alarm information is not
transferred into iHistorian.
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The Field...
Data Add Options

Overwrite Existing Values

Time Options

Treat as DST Timestamp

Specifies...
Whether or not the Classic Migration
Utility overwrites existing values that have
the same timestamp as the values being
migrated in an active iHistorian database
during migration.
Whether the migrated data should have a
Daylight Savings Time (DST) Timestamp.
The timestamps are converted to UTC
time by adjusting the time based on the
local computer time zone offset and DST
setting. For more information, refer to
Planning Daylight Savings Time.

Logfile Options
Allows you to configure the following options:

The Field...

Allows you to...

Logfile Location

Modify the default location of the
iFIX2IhMigration.LOG file.

2. Migrating Classic Historical Data
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The Field...

Allows you to...

Log Migrated Samples

Create a log file of all raw samples
migrated. This will cause all the values,
timestamps, and qualities to appear in the
log file.
NOTE: Selecting this option significantly
slows the performance of historical data
migration.

Overwrite Logfile
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Set whether or not the log file gets
overwritten with each migration. By
default, there is one log file
(iFIX2IhMigration.LOG) that is
overwritten each time you migrate data.
Clearing this option causes the iHistorian
Classic Migration Utility to append to the
log file each time you migrate data.

Readback Options
Allows you to set the following options:

Use This Field...

To...

Readback Values

Immediately read back samples after they are written. This
verifies that the migration was successful. All samples that
were written, including bad data quality and shutdown
markers, are read back.
NOTE: Selecting the Readback Values option puts
additional load on the archiver and can slow the migration
process.
If samples are not found during the readback, the Migration
Utility sends a message to the migration log file
(\dynamics\local\ifix2ihmigration.log). It does not stop the
migration.

Write Values to Server

That the data writes and tag adds are written to the Archiver.
If you want to perform a readback-only migration, clear this
option and select the Readback Values option. This allows
you to select a specific Classic historical file and perform a
readback to confirm that all samples in the Classic file exist
in iHistorian. If samples are not found during the readback,
the Migration Utility sends a message to the migration log
file (\dynamics\local\ifix2ihmigration.log). It does not stop
the migration.

2. Migrating Classic Historical Data
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3. Migrating Advanced Historian Data
The Advanced Historian to iHistorian Migration Utility allows you to migrate
Advanced Historian data into iHistorian. Before beginning to migrate your Advanced
Historian data, plan your migration thoroughly. Refer to Planning Your Migration
for more information.
Once you have established your migration options, perform the following steps:
[1]

Add the iHistorian Toolbar to the iFIX v2.5 or later WorkSpace. How?

[2]

Explore the Advanced Migration Utility Options. How?

[3]

Use the Classic Historian Migration Utility to migrate historical tag groups.
How?
IMPORTANT: If you plan to run the Advanced Historian to iHistorian
Migration Utility on a non-SCADA node, migrate the groups after running the
utility. If you try to migrate the groups first, you will not have correct EGU
information for the iFIX/Advanced Historian historical tags.

[4]

Migrate Advanced Historian Local Data or, How?
Migrate Advanced Historian Remote Data. How?

Exploring the Advanced Historian to iHistorian
Migration Utility
You can open the Advanced Historian to iHistorian Migration Utility, shown in
Figure 3-1, by selecting Migration Tool for Advanced Historian from the iHistorian
directory in the Start menu.
Some of the options you can configure include:
Advanced Historian Connection Information – Displays information for the
Advanced Historian machine you are migrating your historical data from.

3. Migrating Advanced Historian Data
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iHistorian Information – Displays the information for the iHistorian Server that you
want to migrate your historical data to.
Migration Options – Allows you to select all or specific tagmasks and set the time
range for migration.
Migration Status – Displays the current status of the migration.
Migration History – Displays the history of all migrations that have occurred on that
machine.
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Figure 3-1: Advanced Historian to iHistorian Migration Utility

3. Migrating Advanced Historian Data
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Advanced Historian Connection Information
The Advanced Historian Connection Information section displays information for the
Advanced Historian machine you are migrating your historical files from.

Field

Description

Computer Name

The name of the machine you want to
migrate the Advanced Historian data from.

Username and Password

The username and password if you had
Advanced Historian security configured
for archives.

iHistorian Information
The Historian Information section displays the information for the iHistorian Server
that you want to migrate your historical data to.
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Field

Description

Computer Name

The iHistorian Server to migrate ADH
tags and data to.

Username and password

If you have created and established
Security Groups in your iHistorian
Security Environment, you may need to
enter the username and password here. By
default, if you do not supply any
information, the current logged in user
will be checked. For more information on
setting up iHistorian Security, refer to the
Implementing iHistorian Security.

Migrating Advanced and Classic Historian Data

Migration Options
The Migration Options section allows you to select all or specific tagmasks and set
the time range for migration.

The Field...

Allows you to...

Tagname Mask

Specify certain tags for migration only
(*A_CV for instance) or select all tags (*).

Starting Date

Select a starting date for migrating data.

Ending Date

Set an ending date for migrating data.
NOTE: The Migration Utility migrates
data up to but not including the specified
Ending Date. Carefully select your
Ending Date to ensure that you include all
required data in the migration.

Configure New Tags as
Required

Specify whether the Migration Utility
automatically creates tags upon migration,
or migrates data only for tags that already
exist in the iHistorian tag database. This
allows you to manually create the tags you
want to migrate in iHistorian first, then run
the migration only for those tags.

Use Tag Configuration from
iFIX

Maintains tag specific configuration for
iFIX tags. If you do not select this option,
iHistorian uses its tag configuration
default settings when migrating iFIX tags.
For example, if you have an EGU set to
25-55 in an iFIX tag and you clear this
option, the tag migrates with an EGU of
0-100.

3. Migrating Advanced Historian Data
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The Field...

Allows you to...

Allow Updates to Existing
Data

Selecting this option allows iHistorian to
replace data if data already exists for the
tag at that timestamp.

End of Collection Marker

Write a bad DQ data point for each tag
when the migration concludes. Select this
option if you do not want your trend
applications to display a continuos plot of
the last good sample for that iHistorian
tag.

Migration Status
Displays the current status of the migration progress. The Migration Status Window
provides real time migration status including the currently migrating tag and the tag
range (2 of 1000) status. This window also allows you to start the migration process
and abort it once it has started.

Migration History
Displays a log of what times and tag masks were migrated and the status (success/
failure) of that migration. The information displayed in the Migration History
window is also available in the log file, typically located in the C:\Program
Files\iHistorian\LogFiles folder.

Migrating Your Groups
Migrate your groups using the Classic Historian Migration Tool. This allows you to
maintain any configured collection rates and deadbands.
IMPORTANT: If you plan to run the Advanced Historian to iHistorian Migration
Utility on a non-SCADA node, migrate the groups after running the utility. If you try
to migrate the groups first, you will not have correct EGU information for the iFIX/
Advanced Historian historical tags.
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To migrate your Advanced Historian groups into the iHistorian:
[1]

Open the Classic Migration Utility from the iHistorian Toolbar.

[2]

Select Configure Options from the Options menu.

[3]

Select or clear the Overwrite Existing Tags option. This is the only option that
applies to group migration. For more information, refer to the Configuring
Classic Migration Options section.

[4]

Select Migrate Collection Groups from the File menu. The Utility prompts
you to specify if you would like to migrate all groups.
The iHistorian Classic Migration Utility connects to the specified server and
migrates the groups.
NOTE: When migrating groups, Qualifier and Phase parameters are not
migrated. If a group is not active, it is still migrated to the iHistorian with a
collection rate.

Migrating Existing Advanced Historian Data
When migrating Advanced Historian data, you can only run the migration from a
node that either has the Advanced Historian Server or the Advanced Historian client
installed. Also, ensure that Automatically Create Archives is enabled in the
iHistorian Administrator.
To migrate your Advanced Historian data from an existing Advanced Historian node
to your iHistorian Server:
[1]

From the Start menu, select the Migration Tool for Advanced Historian from
the iHistorian directory. The Advanced Historian to iHistorian Migration
dialog box appears, as shown in Figure 3-1.

[2]

Enter the name of the Computer from which you are migrating the Advanced
Historian data.

[3]

If you configured Advanced Historian security, enter the username and
password for security.

3. Migrating Advanced Historian Data
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[4]

The Advanced Historian Migration Tool automatically detects and displays
the default server in the iHistorian Connection Information Computer Name
field. If you want to change the server you migrate data to, enter that server
name in the Computer Name field of the iHistorian Connection Information
section.

[5]

If necessary, enter a username and password in the iHistorian Connection
Information Username and Password fields.
If you do not provide a username and password, security defaults to check the
currently logged in user.
If you are already logged into NT or Windows 2000 with an account with
rights to the iHistorian Server, you do not have to supply a new username and
password.
NOTE: You must have Write, Tag Administrator, and Read privileges in
order to run the migration. Intellution recommends that Security
Administrators run the migration, for best performance.

[6]

If you do not wish to migrate all tags, enter a tagname mask for selected tags.

[7]

Select a start and end date from the drop-down calendars.
NOTE: For more information on estimating migration time, please refer to
the Estimating Migration Time section of this manual.
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[8]

If you want the Migration Tool to create tags automatically if they do not
exist, leave the Configure New Tags as Required option selected. For more
information on this setting, refer to the Planning Migrations with Online
Systems section.

[9]

If you do not wish to overwrite existing values with migrated values
containing the same timestamp, clear the Allow Updates to Existing Data
option.

[10]

If you do not want your trend applications to display a continuos plot of the
last good sample for that iHistorian tag, select the End of Collection marker.
For more information on this setting, refer to Migration Options.

[11]

Click the Start Migration button.
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[12]

Refer to the Migration History window and the log file for information on the
success of the tag migration and any errors or problems encountered during
migration.

You can re-run the migration utility for any time period.

Migrating Remote Advanced Historian Data
This section describes how to migrate your Advanced Historian Data from a remote
machine. Before migrating your Advanced Historian Data, ensure that you have
installed the required software correctly. Refer to the Recommended Software
Installation Order section for more information.
If this procedure is not run as listed, you may experience problems inserting a chart
control into the iFIX WorkSpace, running any programs using fixtools.dll or
fixhdadll.dll, or running certain iHistorian features. Several *.dll(s) are replaced by
older versions by the Advanced Historian. When AH is removed, it replaces the older
versions with the originals and iHistorian works correctly.
To migrate remote Advanced Historian Data:
[1]

[2]

Ensure that PI services are running on the remote machine.
[a]

Double-click the Services icon in the Control Panel. The Services
dialog box appears.

[b]

Locate the Services beginning with ‘PI’. All should be started except
for PI Shutdown.

Ensure that all needed archives are listed as registered.
[a]

Open the MSDOS prompt.

[b]

Navigate to the …Dynamics\AdvancedHistorian\adm directory.

[c]

Enter ‘piartool –al’ to list the registered archive files.

[d]

Register any unregistered archive files that you need to migrate by
typing ‘piartool –ar ‘ + {fully qualified archive name.}
Example :
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piartool –ar c:\Dynamics\archives\DynamicArchive.001

[3]

On the local machine (machine with iHistorian loaded), run the Migration
Utility.
[a]

From the Start menu, select the Migration Tool for iHistorian in the
iHistorian directory. The Advanced Historian to iHistorian Migration
dialog box appears, as shown in Figure 3-1.

[b]

Enter the name of the remote computer you are migrating the Advanced
Historian data from.

[c]

If you configured Advanced Historian security, enter the username and
password for security.

[d]

The Advanced Historian Migration Tool automatically detects and
displays the default server in the iHistorian Connection Information
Computer Name field. If you want to change the server to which you
will migrate data, enter that server name in the Computer Name field of
the iHistorian Connection Information section.

[e]

If you have set up security on your iHistorian Server, enter a username
and password in the iHistorian Connection Information Username and
Password fields.
If you do not provide a username and password, security defaults to
check the currently logged in user.
If you are already logged into NT or Windows 2000 with an account
with rights to the iHistorian Server, you do not have to supply a new
username and password. You must have Write, Tag Administrator, and
Read privileges in order to run the migration. Intellution recommends
that Security Administrators run the migration, for best performance.
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[f]

If you do not wish to migrate all tags, enter a tagname mask for selected
tags.

[g]

Select a start and end date from the drop-down calendars. Intellution
recommends migrating data in two month time blocks, from the oldest
data to the newest. For more information on estimating migration time,
please refer to the Estimating Migration Time section of this manual.
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[h]

If you want the Migration Tool to create tags automatically if they do
not exist, leave the Configure New Tags as Required option selected.
For more information on this setting, refer to the Planning Migrations
with Online Systems section.

[i]

If you do not wish to overwrite any information in existing tags, clear
the Allow Updates to Existing Data option.

[j]

If you do not want your trend applications to display a continuos plot of
the last good sample for that iHistorian tag, select the End of Collection
marker. For more information on this setting, refer to Migration
Options.

[k]

Click the Start Migration button.

[l]

Refer to the Migration History window and the log file for information
on the success of the tag migration and any errors or problems
encountered during migration.

Recommended Software Installation Order
Before migrating your remote Advanced Historian Data, ensure that you have
installed the required software correctly on your local machine. Intellution
recommends the following installation order.
[1]

Install iFIX 2.6 or higher.

[2]

Reboot your computer.

[3]

Install Advanced Historian.

[4]

[a]

Select Custom Installation with ONLY Client install.

[b]

Reboot your computer.

Install iHistorian completely.
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Removing Advanced Historian (From Local Machine)
After you have completely migrated your remote Advanced Historian Data,
Intellution recommends that you remove Advanced Historian from your local
machine.
To remove Advanced Historian from your local machine:
[1]

Stop all PI services from the Control Panel Services Dialog box.
[a]

Double-click the Services Icon in the Control Panel. The Services
dialog box opens.

[b]

Locate the PI Network Manager Service and click the Stop button.

[2]

Another dialog box appears asking if you would like all the other services
stopped. Click Yes.

[3]

Locate the bufserv service and stop it.

[4]

Completely remove Advanced Historian using the uninstall feature in the Add/
Remove Programs dialog box.

[5]

Reboot your computer.

[6]

Delete the \AdvancedHistorian directory from the Dynamics base path.
NOTE: You may want to stop PI Services again, as detailed in step 1.
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[7]

Use the AHClean utility located on the Intellution web site in the Developers
Corner.

[8]

Run AHClean.exe and click the Clean Registry button.

[9]

Reboot your computer.
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